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Introduction 

 Introduction 
This tutorial describes how to get up and running to use Simplify3D to print with your FELIX printer. 

It assumes you have access to the Simplify3D website and that you are familiar with the basic user interface elements. 

The tutorial will not describe in detail how to configure all the parameters of the application. 

For more detailed information about the options, please check the Simplify3D website: 

https://www.simplify3d.com/support/ 

The tutorial assumes you are going to use the latest Windows version (Simplify3D 3.1.0) and that you have a FELIX Pro 

series printer connected to the computer (this is a dual head printer). 

The tutorial can also be used for Felix 3 series printers, but some details will look a little different. 

 What can Simplify3D do? 
The Simplify3D application has four important functions: 

 It allows you to import a 3D file and view and manipulate it so it can be printed by the printer 

 It allows you to preview a prepared print job file 

 It can communicate with the printer to feed it a print job via a USB cable.  

 It provides a user interface to manually control the printer from a computer  

 Installing Simplify3D 

3.1 Preparation 
Please make sure the computer, on which you are going to install Simplify3D, has access to the internet. 

Personal firewalls, virus scanners and corporate firewalls are known sources for interference with the installation 

process of the software. 

You can find and download the installation file here: 

http://www.felixprinters.com/downloads/?dir=software/3_Simplify3D 

Choose the version for your operating system. 

If you experience connection problems later on with the FELIX 3 series printers, it is recommended to install the latest 

FTDI VCP serial port drivers. You can find them here: http://www.ftdichip.com/Drivers/VCP.htm 

If you experience connection problems later on with the FELIX Pro series printers, it is recommended to install the 

latest Arduino Due drivers. See chapter 15.1.1 of the Felix Pro series user manual. 

3.2 Installation 
Execute the downloaded installation file. 

After a while, you will be presented with a setup wizard. Read and accept the license agreement. 

Choose an installation path for the program. The program will be installed. 

When you start the program for the first time, it will ask you to login with your Simplify3D user account. The username 

and password for the account should have been provided to you when you bought the license from us or someone 

else. 

http://www.felixprinters.com/
https://www.simplify3d.com/support/
http://www.felixprinters.com/downloads/?dir=software/3_Simplify3D
http://www.ftdichip.com/Drivers/VCP.htm
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Installing Simplify3D 

 

After that, a “Configuration Assistant” will show up. Select the Felix printer that you will use: 

 

(the Configuration Assistant can be accessed at any time by going to Help > Configuration Assistant). 

Next, the program will open. 

The installer is bundled with a set of printing profiles that is not so recent anymore. 

To get the latest version of profiles for the program, look at our website: 

http://www.felixprinters.com/downloads/?dir=software/3_Simplify3D 

Please make sure you use the latest profiles for our printer. We are regularly finetuning our settings, improving and 

expanding them. 

 

http://www.felixprinters.com/
http://www.felixprinters.com/downloads/?dir=software/3_Simplify3D
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User interface 

Download the latest profile file (something like “20161024 - Felix Pro Series - slice profiles.fff”). 

Import the downloaded profile file via the menu “File/Import FFF profile”: 

 

Note: the newly imported profiles will show up as a new printer, be sure to select the latest profiles when you prepare a print 

job (see 6.4). 

The program is now ready for use. 

 User interface 
First, open the application. The main software interface will present itself. 

The components of the interface are organized as follows: 

 

If you “hover” the mouse arrow above a button or text field, a short explanation will appear for most items.  

http://www.felixprinters.com/
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Connecting to the printer 

 Connecting to the printer 
The Simplify3D software will try to connect to you printer automatically when it starts up. You can check if everything is 

as you would expect it to be with the “Tools/Machine Control Panel”: 

 
The control panel will show up: 

 

Here you can see that the printer indeed is connected. You can also see what serial port and what communication 

speed is used. The panel also allows you to manually manipulate your printer.  

http://www.felixprinters.com/
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Preparing a model for single head printing 

Double-click 

 Preparing a model for single head printing 

6.1 Create a 3D file 
Simplify3D accepts 3D files in the STL file format and OBJ file format. 

If you designed a 3D object yourself, you need to export it from the design software into one of these formats. 

The STL format is the most commonly used format in the 3D printing community. 

Note which dimensional unit you use for the export (for example, millimeter). 

In this tutorial we assume you are going to print an STL file that has the mm as unit. 

6.2 Import the 3D file 
Click “Import” in the Models section and navigate to the folder where you saved your file. Select it. 

 
You can also drag-and-drop file(s) onto the Build Table. 

Click on “Center and Arrange” to move your model(s) to the center of the build plate. 

Use Tool Bar options (listed vertically on the right side of the window) to view and manipulate your model. 

6.3 Orient the part 
Now, take a look at the Models area of the interface. 

 
The list shows the imported objects. If an object is selected, it will get another shade in the view area. 

If you double-click a part in the models list, you can directly edit some key properties of the part. 

http://www.felixprinters.com/
https://en.wikipedia.org/wiki/STL_(file_format)
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Preparing a model for single head printing 

If for some reason you are not satisfied with the position of the object, you can change it by using one of the 

manipulation tools. 

All manipulations will be applied to the currently selected parts. 

For example, if you want to rotate an object, select it and click the “Rotate Models (R)” button . 

The tool allows you drag the object around the Z axis with a manipulator.  

Not all tools are available in the tool bar area, some extra tools are in the “Edit” menu.  

It is left to the reader to explore the rest of the manipulation tools. Look here for more information: 

https://www.simplify3d.com/support/articles/importing-and-manipulating-your-models/ 

6.4 Choose the process 
Simplify uses the concept of processes to determine how each 3D part should be treated. 

The process defines what extruder will be used, what material parameters should be used, etc. 

By default, one process (Process1) is assigned to all parts on the platform. 

(If somehow you don’t see a process in the “Processes” window, add at least one with the “Add” button) 

To edit a process, double-click the process name: 

 

The FFF settings window will open. Here you can choose what printer profile you want to use. 

Make sure you select the profile that corresponds with the latest set of profiles you imported in chapter 3.2 

 

The FFF Settings window contains all the settings that specify how your model will be constructed: 

http://www.felixprinters.com/
https://www.simplify3d.com/support/articles/importing-and-manipulating-your-models/
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Preparing a model for single head printing 

 Select Profile: Loads a printer profile and the corresponding settings, which have been selected to ensure 

optimum quality. 

 Auto-Configure for Material: Adjusts temperature, extrusion, and cooling settings based on the material you 

select. 

 Auto-Configure for Print Quality: Adjusts layer height, infill density, and other quality settings based on the level 

you desire. 

 Auto-Configure Extruders: This selection box appears if you selected a printer with multiple extruders. Select 

the extruders that you intend to use and they will be automatically enabled. 

 Infill Percentage: Adjusts the interior solidity of your 3D print. 0% is completely hollow and 100% is completely 

solid. A value in the range of 20-50% is frequently used. 

 Include Raft: Generates a raft structure underneath your part. Rafts are used to improve the bond to your 

build platform and may help reduce warping on large models. A raft can also compensate for slight leveling 

issues if you have difficulty with first layer adhesion. 

 Generate Support: Turns on the Support Generation Tool. Support structures are used when your model has 

steep overhangs or unsupported areas. Typically, overhangs greater than 45º benefit from support material 

underneath it. Simplify3D also allows you to customize the location of your support structures; simply click to 

add or delete! Support structures break away cleanly and easily, minimizing damage and ensuring high quality 

models. 

There are also a few buttons: “Show Advanced” will show all the specific details of the current process. 

“Select models” allows you to select which models the current process will be assigned to. 

Click “OK” when you have finished configuring your settings in the FFF Settings window. At any time, you can modify the 

settings by double-clicking on the Process in the list, or by clicking Edit Process Settings. 

6.5 Example 
So, let’s assume you want to print an imported object in PLA with print head 1. 

Make sure you select the profile that corresponds with the latest set of profiles you imported in chapter 3.2 

 
Set the “Auto configure for Material” to “00_PLA_FELIXPrinters”. 

Leave the “Auto configure for Print quality” at “Normal Quality (200 micron)”. 

Leave the “Auto configure Extruders” at “Left extruder only”. 

Choose the infill at a convenient value, say 25% or 30%. 

6.6 Generating a preview 
Now, we are curious of course what the slicing program will tell the printer to do. 

First, we will tell the program to prepare the models for us as we specified in the process settings. 

http://www.felixprinters.com/
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Preparing a model for single head printing 

To do that, first click the “Prepare to Print!” button: 

 

The program will start preparing the imported model. 

To prepare a 3D object for printing, the object data must be processed into a format that the 3D printer understands, 

the so-called “G-code”. 

This processing is called “slicing” since the software (virtually) cuts the 3D objects into slices. 

The software will generate an optimal path for the print head to recreate each slice in plastic. This is a rather complex 

trick, so it will take some time (sometimes a lot of time for big and complex objects). 

The printer eventually will stack each calculated slice (also called layer) on top of the previously printed slice. 

When the slicing is done, Simplify3D will transition to the Preview Mode. 

 
The animated Preview Mode allows you to inspect all aspects of your print operation prior to execution. The software 

reads the G-Code and displays line-by-line or layer-by-layer how your model will be constructed.  

http://www.felixprinters.com/
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Preparing a model for single head printing 

The Preview provides interactive buttons for precise inspection of your build sequence: 

 Play/Pause Button: Animates the Preview by line or by layer. 

 Start and End Slider Bars: Allow you to move through the Preview manually. 

(Hint: leave the Start slider positioned left and drag the End slider right to view the entire build sequence.) 

A useful setting is to select “Preview by Layer”, and also place a checkmark in “Single Layer Only”. 

Together, these selections will allow you to view one layer at a time. 

If you want to make further adjustments to your model or process before printing, click “Exit Preview Mode”. This is a 

great time to ensure that your model is constructed properly. 

The Preview Window also contains estimates about your print project. These Build Statistics appear in the top left 

corner of the Preview window. 

 Build Time: How long it would take for your print to finish. 

 Filament Length: How much filament it will take to build your model. 

 Weight: How much the print will weigh when completed.* 

 Material Cost: An approximation of how much it will cost to make your part.* 

*: To adjust the density or cost per kg values, please select “Edit Process Settings”, then browse to the “Other” tab. 

You can see in the Preview window that the program has added extra material. 

This material provides the support for the parts that would otherwise fall down or deform too much. The material 

must be removed later, after the print job is finished. 

The slicer program uses some tricks that help easing the separating of the support structure from the printed part. 

Simplify3D allows you to manipulate this support structure. This topic is beyond the scope of this tutorial. You can 

learn more about it here: 

https://www.simplify3d.com/support/articles/adding-and-modifying-support-structures/ 

6.7 Print the file 
Note: It is assumed the printer has been fully calibrated before. If not, check the FELIX Pro series / Felix 3 user manual to see 

how the printer should be calibrated. 

Make sure the Simplify3D program is connected to the printer (see chapter 5) 

If it is connected, check / make sure that the following is true: 

 The printer axes can move without obstructions 

 All plastic residues on the heated bed are removed, preferably with the supplied tweezers 

 The heated bed surface is clean and degreased (blue spirit is the preferred cleaning agent). 

 When all axes are homed, the hot-end is not touching the table. 

Make sure the table is moved at least 10mm away from the extruder tip and insert the right filament in the extruder.  

Run the extruder until a steady flow of plastic comes out. 

See also the printer manual (“loading filament into printer”) 

From the Preview window, click the “Begin printing over USB” button: 

http://www.felixprinters.com/
https://www.simplify3d.com/support/articles/adding-and-modifying-support-structures/
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Preparing a model for single head printing 

 
The printer will start the print job. 

The program will show a simulation of the print job, so you can check what is going on with the printer. 

It will also display a progress indicator in the right bottom part of the preview window. 

You can pause or cancel the current job by opening the Machine Control Panel and clicking the Pause/Resume or Stop 

buttons. 

 

6.8 Save the print job 
It is also possible to save a prepared print job. 

The job will be saved as a so-called “g-code” file. 

This file can be sent to another location with the same FELIX printer, or it can be stored for repeated print jobs or 

batch printing. 

Another very practical use of a g-code file is that you can make the printer print without having to be connected to a 

computer. In case of a lengthy print job this minimizes the risk of interrupted communication because the computer 

decides to run an update, go to sleep mode, crash, … 

It also saves energy. 

To print the saved print job, you need to copy the g-code file on a micro SD card, insert the card into the printer and 

then start the print job from the printer interface. See the printer user manual for more details. 

To save the prepared print job, you first must have sliced a 3D object with the right settings. 

Then, from the preview window, press the “Save Toolpaths to Disk” button: 

http://www.felixprinters.com/
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Preparing a part for dual head printing 

 

This saves your print file to a user-defined location, such as a folder on your computer or an SD card. The software will 

save a .gcode file. 

 Preparing a part for dual head printing 

7.1 Starting points 
Dual head prints expand the possibilities of what kind of objects you can print. You can print objects with more colors. 

You can create objects with different properties (for example a wheel with a PLA (tough) rim and a Flex (soft) tire. 

You can also print the supporting structure in a material that is soluble in water or limonene. That allows you to print 

virtually any shape and eliminates the tedious process of manually chipping off the support structure. 

For dual head printing, you (obviously) need a dual head printer. 

You also need a 3D model that consists of multiple parts. You can determine per part what print head will be used for 

printing that part. 

It is important that the 3D models for the different print heads share the same origin, otherwise the object will not be 

imported at the position where they fit together perfectly. 

You will also need some experience with printing single head prints successfully. Printing dual head files is more 

difficult because more things can go wrong. If you are unable to successfully print single head jobs, please keep 

practicing to master it. Only then move on to dual head printing. 

7.2 Importing the parts 
This is an example of a simple 2 color CAD model, a key chain with rotating parts: 

   

The objects have been exported as two STL files each containing 2 parts. 

The exported STL files have been imported in Simplify3D, just the same as in 6.2. You can select multiple files to 

import. 

http://www.felixprinters.com/
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Preparing a part for dual head printing 

Each imported object will be placed in the Models tab: 

  

There are two ways of proceeding from here on: 

 We can manually postion the parts and then assign different processes to the parts 

 We can start the “Dual Extrusion wizard” from the “Tools” menu. 

In this tutorial we will not use the wizard. This allows us to explain what is going on. 

You can look here for more information on the wizard: 

https://www.simplify3d.com/support/articles/printing-with-multiple-extruders/ 

The imported objects are treated as two separate entities. This is not so conventient in this case. 

So we group them by selecting them and selecting “Edit/Group Selection” from the menu. The models will be grouped:  

  

http://www.felixprinters.com/
https://www.simplify3d.com/support/articles/printing-with-multiple-extruders/
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Preparing a part for dual head printing 

They still are not aligned properly. Select: “Edit/Align Selected model Origins” to make that happen: 

   

Orient the parts 

Because you grouped the parts together, they will move as one object. You can use the “Place surface on bed” tool to 

select a surface on the object you want to put on the table.  

 

7.3 Create processes 
Insert a new process “Left Head” or rename the default one to this name: 

 

http://www.felixprinters.com/
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Preparing a part for dual head printing 

Set the “Auto-configure Extruders” to “Both extruders”. Select PLA as Material. 

Click the “Show advanced” button, select the “Layer” tab and tell the process to use the “Left extruder” in this process. 

We don’t need a support structure for this model, so we uncheck that box. You can tweak other settings if you like. 

Then click “Select Models” and highlight the models you want to print with the left head. 

Next, create a new Process with the “Add” button.  

Name this process “Right head”, set things up the same way as for the left extruder, but now choose “Right extruder” in 

the Layer tab. Again, select the models you wish to print with the right head with the “Select Models” button. 

This time, if you press the “Prepare to print!” button, the program will ask a question: 

 

Select that you want to print both processes. Make sure you also select the “Continuous printing” option.  

Look here for more details on the multi-part / multi-head printing options: 

https://www.simplify3d.com/support/articles/multi-part-printing/ 

7.4 Previewing 
You can preview the print job just as with a single head print (see 6.6). 

You can see the left and right extruder lines in different colors by setting the Coloring to “Active Toolhead” 

 

http://www.felixprinters.com/
https://www.simplify3d.com/support/articles/multi-part-printing/
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Printing a part with soluble support 

You can also see that an extra structure is added (the wipe and prime tower). This structure helps the extruder to get 

going after it has been idle for a while, and it will increase the chance of wiping off any excess filament that could be 

hanging from the idle extruder. 

7.5 Print/Save the file 
Printing and saving the job is pretty much the same as a single head print, see 6.7 and 6.8. 

When printing the job, you will see that the printer will alternate which head it is using. It will wait a while in between to 

allow the active extruder to reach the right temperature. At the same time the printer will lower the temperature of 

the idle extruder to prevent It to drip molten material on the object. 

 Printing a part with soluble support 
Printing a part that has a support structure that is made of another material is very similar to dual head printing. 

The difference is you don’t need to have a 3D object in two separate parts, since the support structure is generated by 

Simplify3D itself. 

This means you also only have to have one process configured. 

To instruct the program to prepare a job like this: 

   

So:  

 We choose a material preset for PLA in the left head and a water-soluble material (PVA) in the right print head. 

 The profile takes care of the support structure now being put tightly against the model instead of loose, since 

the material does not have to be chipped of but can be just dissolved. 

 You need to check if the correct head is used for the part material; also check if “Both extruders” are 

configured. 

  

http://www.felixprinters.com/
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Felix Support 

The rest of the printing process is identical to that of single or dual head printing (see 6 and 0). 

This is a preview of the output of the slicing program: 

 

 

 

 

 

 

 

 

 Felix Support 
If you are unable to continue or have any questions, you can check at the support section of our website or you can 

contact us directly: 

Website:  www.felixprinters.com/support 

Email:  support@felixprinters.com 

Telephone: +31 (0)30 30 31 387 

Address: Zeemanlaan 15, 3401MV IJsselstein, The Netherlands 

 

Kind regards, 

FELIXprinters 

http://www.felixprinters.com/
http://www.felixprinters.com/support
mailto:support@felixprinters.com

